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IMPORTANT SAFETY MARKINGS 
 
The following symbols are used throughout this User Guide to advise you of important instructions: 
 

 

This symbol warns the presence of a voltage of sufficient magnitude to cause a 
severe or fatal electric shock. Follow the appropriate instructions carefully to  
avoid the risk of injury. 
 

 

 

This symbol indicates an important instruction for the correct and safe installation, 
operation or maintenance of your RGB ADAPTER system. Failure to comply with 
such instructions may result in injury to personnel or damage to the RGB ADAPTER 
hardware. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

The ES3610 product conforms with the protection requirements of the EC Directive 
89/336/EEC (relating to Electromagnetic Compatibility) and EC Directive 73/23/EEC 
(relating to Low Voltage) by application of the following standards: 

     EN 55022:1994 Class A;     EN 55024:1994 Class A;     EN60950:2000 

 
The ES3611 product conforms with the protection requirements of the EC Directive 
89/336/EEC (relating to Electromagnetic Compatibility) and EC Directive 73/23/EEC 
(relating to Low Voltage) by application of the following standards: 

     EN 55022:1994 Class B;     EN 55024:1994 Class B;     EN60950:2000 

 
Provided that: 

• The product is used in accordance with the manufacturer’s instructions. 

• The product is not connected to any peripheral equipment that is not CE marked. 

 



Contents  ES3610/11 User Guide 

Page 4  I447GB issue 6 

 

Contents 

Contents .............................................................................. 4 

SECTION 1: .......................................................................... 7 

Introduction.............................................................................................7 

What is the VN-GLIMPSE RGB ADAPTER? ................................................................ 8 
Single or Multiple Users ............................................................................................................... 8 
Typical System Application .......................................................................................................... 9 

Front Panel Features.................................................................................................. 10 
Indicators ................................................................................................................................ 10 

Rear Panel Features ................................................................................................... 11 
Power Supply Input................................................................................................................. 11 
Network Connector ................................................................................................................. 11 
Keyboard Connectors ............................................................................................................. 11 
Mouse Connectors.................................................................................................................. 11 
Monitor Connectors ................................................................................................................ 11 
Serial I/O Connectors ............................................................................................................. 11 

Source Compatibility.................................................................................................. 12 
Control Capability....................................................................................................... 13 
Accessories ................................................................................................................ 14 

Supplied Accessories ............................................................................................................. 14 
Optional Accessories .............................................................................................................. 14 

SECTION 2: ........................................................................ 15 

Installation ............................................................................................15 

Choosing a Suitable Location ................................................................................... 16 
Environmental Requirements..................................................................................................... 17 

Orientation .............................................................................................................................. 17 
Temperature ........................................................................................................................... 17 
Ventilation ............................................................................................................................... 17 
Humidity & Water.................................................................................................................... 17 

Rack-mount Requirements ........................................................................................................ 18 
Mounting & Support ................................................................................................................ 18 
Ventilation ............................................................................................................................... 18 
Mains Supply .......................................................................................................................... 18 

Mains Power Connection (via PSU)........................................................................... 19 
Supply Requirements (for PSU)................................................................................................. 19 

Mains Power Cord (for PSU) ...................................................................................... 20 
Power-up Procedure................................................................................................... 20 

Fitting a Mains Plug.................................................................................................................... 21 
Wiring Details.......................................................................................................................... 21 

External Supply Protection......................................................................................................... 22 
Fused Plugs (UK-style)........................................................................................................... 22 
Unfused Plugs or Hard-wired ................................................................................................. 22 

Connecting to a Computer......................................................................................... 23 
Connection Diagram (Digital Source)......................................................................................... 24 



ES3610/11 User Guide  Contents 

I447GB issue 6  Page 5 

Connection Diagram (Analog Source) ....................................................................................... 25 
Connecting the RGB ADAPTER to a Network ........................................................................... 26 

Network Requirements ........................................................................................................... 26 
Setting the Correct IP Address ............................................................................................... 26 

SECTION 3: ........................................................................ 27 

VN-GLIMPSE Setup Utility....................................................................27 

Introduction ................................................................................................................ 28 
Installing the Setup Utility........................................................................................................... 29 

Minimum Computer Specification........................................................................................... 29 
Installation Procedure ............................................................................................................. 29 

Using the VN-GLIMPSE Setup Utility ........................................................................ 30 

SECTION 4: ........................................................................ 34 

VN-GLIMPSE VIEWER.........................................................................34 

Introduction ................................................................................................................ 35 
Installing the Glimpse Viewer..................................................................................................... 35 

Minimum Computer Requirements......................................................................................... 35 
Installation Procedure ............................................................................................................. 35 

Using the VN-GLIMPSE VIEWER ............................................................................... 36 
Source Connection and Disconnection ...................................................................................... 38 
Viewing Options ......................................................................................................................... 39 
Remote Mouse and Keyboard Control....................................................................................... 40 

Using Mouse and Keyboard Control....................................................................................... 41 
Learning Dialogs ........................................................................................................................ 42 
Command line switch options .................................................................................................... 43 

SECTION 5: ........................................................................ 44 

Technical Data......................................................................................44 

Mechanical Data......................................................................................................................... 45 
Operating Conditions.................................................................................................................. 45 
Power Supply ............................................................................................................................. 45 
Control Inputs/Outputs ............................................................................................................... 46 

Keyboard/Mouse Connectors ................................................................................................. 46 
Monitor Connectors ................................................................................................................ 47 
Supported Source Formats .................................................................................................... 48 
Network Connector ................................................................................................................. 49 
Serial (RS-232) Connectors ................................................................................................... 50 

APPENDIX A:...................................................................... 51 

Guide to IP Addressing .........................................................................51 

What is an IP Address?.............................................................................................................. 52 
Private & Public Address Ranges........................................................................................... 52 
Multicast Address Range........................................................................................................ 52 

Choosing IP Addresses.............................................................................................................. 53 
Subnet Mask........................................................................................................................... 53 



Contents  ES3610/11 User Guide 

Page 6  I447GB issue 6 

Using the ‘Ping’ Utility to Test Communications ........................................................................ 54 
Response Messages .............................................................................................................. 54 

APPENDIX B:...................................................................... 55 

Understanding VN-GLIMPSE Performance ..........................................55 

Understanding VN-GLIMPSE Performance............................................................... 56 
What are the performance criteria?............................................................................................ 56 
What can affect these criteria?................................................................................................... 57 

Data Stream ‘Bottlenecks’ ...................................................................................................... 57 
Source Scaling........................................................................................................................ 57 

Adjusting the Encoder Parameters ............................................................................................ 58 



ES3610/11 User Guide  Section 1: Introduction 

I447GB issue 6  Page 7 

SECTION 1: 

Introduction 
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What is the VN-GLIMPSE RGB ADAPTER? 
 
The VN-GLIMPSE RGB ADAPTER is used to distribute an RGB monitor signal from a source 
computer (or similar graphical device) across an IP network to a viewing station. 
 
At its simplest the viewing station can be another computer, running the VN-GLIMPSE VIEWER 
software application. For more advanced applications one of the VISIONETWORK (VN) range of 
image processors can be used, allowing more than one VN-GLIMPSE source to be viewed 
simultaneously (along with other source types) on a target display. 
 
The VN-GLIMPSE RGB ADAPTER uses a fast Digital Signal Processor to provide near real-time loss-
less compression performance and is ideally suited to source images with low to moderate motion. 
 
It also allows keyboard and mouse controls at the viewing station to be used to remotely control 
software applications on the source computer. 
 
The VN-GLIMPSE RGB ADAPTER simply connects between the source computer and its monitor, 
keyboard and mouse. It is fully independent of the source computer operating system or hardware 
manufacturer and does not impair the performance of the source computer in any way. 
 

Single or Multiple Users 
 
By default the VN-GLIMPSE RGB ADAPTER operates in ‘unicast mode’ allowing one user (viewing 
station) to be connected at one time.  
 
Where more than one user (viewing station) is required, the unit can also operate in ‘multicast mode’. 
However, please note that an additional license is required for this mode of operation. 
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Typical System Application 
 
The diagram below shows a typical system application utilizing the VN-GLIMPSE RGB ADAPTER 
allowing a computer source to be viewed on a VISIONETWORK (VN) Processor: 
  
 

 
 
 
The RGB ADAPTER is connected between the source computer and its monitor, keyboard and 
mouse. From these connections the RGB ADAPTER collects data about changes in the display 
content along with keyboard and mouse actions. This data is then made available to a VN-Processor 
which displays a facsimile of the source on the target display. 
 
In addition, if the VN-Processor is equipped with its own keyboard and mouse, then these can be 
used to ‘take control’ of any applications running on the source computer. 
 
The operation of the RGB ADAPTER is completely transparent to the user of the source computer; 
performance of the computer is not affected in any way. 
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Front Panel Features 
 
 

 
 

 

 

Indicators 
 
The following indicators are visible on the front of the RGB ADAPTER: 
 

Name Color Function 

POWER 

 

Green Lit when the unit is receiving power from the 12V supply input. 

NETWORK 

 

Orange Indicates the status of the Ethernet connection: 

Flashing Intermittently – data is being transmitted across the network. 

Unlit – no network connection detected. 

STATUS 

 

Orange Indicates the internal status of the RGB ADAPTER:  

Lit – the unit is working normally and is connected to a valid source. 

Flashing Regularly – the unit is working normally but has no source. 

Unlit – the unit is not functioning correctly. 

 
 
NOTE: When the RGB ADAPTER is powered-up the NETWORK and STATUS indicators will light up 
or flash intermittently for around 15 seconds while the unit initializes. 
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Rear Panel Features 
 

 
 
 
Full details of connector types, pin-outs and specifications can be found in Section 5:Technical Data. 
Briefly, these are as follows: 
 

Power Supply Input 

The RGB ADAPTER requires a 12V power supply via this connector. A suitable mains operated 
power supply unit (PSU) is provided. 

Network Connector 

This connects the RGB ADAPTOR to the viewing station, usually via an Ethernet network. Captured 
image data is output from here. Configuration (if needed) of the RGB ADAPTER is also achieved via 
this connection. See page 27 for further details 

Keyboard Connectors 

Standard PS/2 connectors, used to connect the RGB ADAPTER between the source computer and its 
keyboard. 

Mouse Connectors 

Standard PS/2 connectors, used to connect the RGB ADAPTER between the source computer and its 
mouse. 

Monitor Connectors 

Standard DVD-I connectors, used to connect the RGB ADAPTER between the source computer and 
its monitor. Compatible with both digital and analog sources – see Source Compatibility (page 12). 

Serial I/O Connectors 

Standard 9-pin connectors used to establish a serial data link between the RGB ADAPTER and an 
external computer. These are not used during normal operation. 
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Source Compatibility 
 
The RGB ADAPTER is compatible with both digital (DVI) and analog graphics sources up to UXGA 
resolution (1600 x 1200 @ 60Hz, 24-bit color). See page 48 for a list of standard supported sources. 
 
The RGB ADAPTER incorporates advanced image acquisition circuitry which can auto-detect a wide 
range of source types without the need for any additional setup. 
 
For specialist or non-standard source formats, user customizable source modes can be created and 
downloaded to the RGB ADAPTER. Please consult Electrosonic Product Support for further help and 
advice on using customizable source modes. 
 

IMPORTANT NOTE 
 
The VN-GLIMPSE RGB ADAPTER does not provide Analog-to-Digital or Digital-to-Analog conversion 
via its monitor connections. A digital source must use a digital monitor and an analog source must use 
an analog monitor. 
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Control Capability 
 
Local keyboard and mouse control of the source computer is fully maintained while connected to the 
RGB ADAPTER. In addition, keyboard and mouse functions can be remotely controlled from the 
viewing station. 
 
Little or no internal configuration is required in order to use the RGB ADAPTER. Where access to the 
internal configuration is required this can be achieved using an external computer connected to the 
RGB ADAPTER – either via the Network connector or the COM1 Serial Port. 
 
A configuration software tool is provided. For further details on using this tool, refer to page 30. 
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Accessories 

Supplied Accessories 

 
In addition to this User Guide, the RGB ADAPTER is supplied with the following accessories. If any of 
these items is missing or damaged, please contact your Electrosonic dealer immediately: 
 

Item Qty Re-order Code 

12V Power Supply Unit (PSU) 
Note: ES3610-P has a square-style connector; ES3611-P 
has a round-style connector. 

1 ES3610-P 
ES3611-P 

Mains Cord for PSU (with 3-pin ‘Edison’ plug) 

For use in the USA. 

1 CA4291 

Mains Cord for PSU (bare-ended) 

For use in Europe and all other countries. 

1 CA429 

Mouse/Keyboard Cable (2 metre PS/2 to PS/2)  2 

Digital Monitor Cable (2 metre DVI-D to DVI-D) 1 

Analog Monitor Cable (2 metre 15-pin HD-type to DVI-A) 1 

DVI-A to 15-pin HD Adapter 1 

Clip-on Ferrite*  
For supplied Monitor Cable – see Important Note below. 

1 

 

Digital Cable Kit: 

ES3611-CD 

 

Analog Cable Kit: 

ES3611-CA 

Software Disc 

Containing VN-GLIMPSE Setup Utility, VN-GLIMPSE 
VIEWER and ADMINISTRATOR, plus full documentation. 

1 M20046 

 

* IMPORTANT NOTE: Whether you are using the Digital or Analog Monitor Cable,  
it must be fitted with the Clip-on Ferrite. Position the ferrite nearest to the end of the 
cable that connects to the DVI-I IN connector on the VN-GLIMPSE RGB ADAPTER.  

Refer to the connection diagrams on pages 24 & 25. 

 

Optional Accessories 
 
The following optional accessories are also available for use with the RGB ADAPTER – these must 
be ordered separately from your Electrosonic dealer: 
 

Item Order Code 

Rack Mounting Kit 

A kit that allows one or two ES3610/11 units to be installed in a 
19inch equipment rack. Full instructions are included with the kit. 

ES3611-RM 
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SECTION 2: 

Installation 
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Choosing a Suitable Location 
 
The VN-GLIMPSE RGB ADAPTER is designed to be used either as a free-standing unit or (by using 
the optional kit available) to be mounted in a 19 inch equipment rack. 
 

 

CAUTION 
 
Whichever installation method you choose there are certain environmental 
requirements, detailed on page 17, which must be observed in order to ensure safe 
and reliable operation. 
 
For rack-mounted applications the criteria detailed on page 18, must also be 
observed. 
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Environmental Requirements 
 

 

CAUTION 
 
The criteria on this page must be observed for all installations of the RGB 
ADAPTER, whether free-standing or rack-mounted. 

 

Orientation 

The RGB ADAPTER must be operated in the horizontal position only. When used free-standing it 
must be placed on a stable, flat and level surface. Ensure that the surface finish will not be affected by 
the heat produced by the RGB ADAPTER when in use. 

Temperature 

DO NOT install or operate the RGB ADAPTER in an area where the ambient temperature exceeds 
35°C (95°F) or falls below 5°C (35°F). 
 
Remember that, as with all electronic equipment, the RGB ADAPTER and its associated PSU also 
produces heat which may affect the ambient temperature. 
 
After the RGB ADAPTER has been in use for a period of time the external casing will be very warm to 
the touch. While the temperature is well within safe limits please be aware that it may be hotter than 
you are expecting. Ensure that any adjacent surfaces will not be affected by the heat. 

Ventilation 

No special ventilation is required. However, it is recommended that free air circulation is permitted 
around the unit.  

Humidity & Water 

DO NOT install or operate the RGB ADAPTER in an area in which the ambient relative humidity 
exceeds 85% or in an area that is prone to condensation. 
 
DO NOT install or operate the RGB ADAPTER near water or in a location which may be prone to 
water seepage — the RGB ADAPTER is not waterproof. 
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Rack-mount Requirements 
 

 

CAUTION 
 
For rack-mounted installations, the following criteria must be observed (in addition to 
the Environmental Requirements listed on page 17) 

 

Mounting & Support 

ALWAYS use the special rack-mount kit (available separately) to secure the RGB ADAPTER.  Full 
details on using the kit are included with the kit. 
 
DO NOT stand other units directly on top of the RGB ADAPTER when it is rack-mounted as this will 
place excessive strain on the mounting brackets. 

Ventilation 

ALWAYS ensure that the rack enclosure is adequately ventilated. Sufficient airflow must be achieved 
(by convection or forced-air cooling) to satisfy the ventilation requirements of all items of equipment 
installed within the rack. 
 
A ventilation gap of at least 44mm (1U) is recommended above and below the RGB ADAPTER and 
adjacent surfaces or equipment. 

Mains Supply 

ALWAYS ensure that the mains power supply is of the correct voltage and frequency for all 
equipment within the rack, and that it has a good ground/earth connection. 
 
Where a power strip (mains distribution batten) is used (of either a hard-wired or plug and socket 
type), always ensure that the current rating of both the power strip and the supply is sufficient for all 
equipment within the rack. 
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Mains Power Connection (via PSU) 
 
The RGB ADAPTER must be powered from a 12 Volt DC regulated supply. A suitable mains-operated 
power supply unit (PSU) is provided. The mains connection details that follow relate to the PSU. 
 

 

NEVER CONNECT THE RGB ADAPTER DIRECTLY TO THE MAINS. 

ALWAYS use the PSU provided. If a backup/replacement PSU is required, 
always use an Electrosonic approved PSU. 
 

 

Supply Requirements (for PSU) 
 

 

ALWAYS observe the following instructions to ensure safe and reliable 
operation of the PSU. 

 
 
ALWAYS ensure that the mains supply voltage is single phase only and is within the permitted range: 
 

• 100 – 240V AC (0.45A Max.) 50 – 60Hz. 
 
NEVER connect the PSU to a DC supply. 
 
DO NOT allow the mains power point to be overloaded. This is particularly important to check when 
powering several items of equipment from a single power point (e.g. within rack-mounted 
installations). 
 
WARNING: To avoid the possible risk of electric shock or product damage due to condensation, 
ALWAYS allow the PSU to become acclimatized to ambient temperature and humidity for at least 
thirty minutes BEFORE switching on. This is particularly important when moving the unit from a cold 
to a warm location.  
 
NOTE: The PSU is double-insulated and does not require an earth/ground connection. 
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Mains Power Cord (for PSU) 
 
The mains PSU is equipped with a 3-pin (male) type mains connector which requires a power cord 
fitted with a corresponding 3-pin IEC320 (female) connector. 
 
Two power cords are supplied with the PSU, each having a different termination; you must use the 
lead appropriate for your country: 
 

In... Use the... Re-order Code 

USA and Canada cord fitted with the 3-pin  
American-style ‘Edison’ plug. 

CA4291 

UK, Europe and all 
other countries 

unterminated cord and fit a 
suitable plug as described on 
page 21. 

CA429 

 
WARNING: Do not allow anything to rest on the mains power cord. 
 
 
 

Power-up Procedure 
 
You must always ensure that the RGB ADAPTER is powered-up at the same time as the source 
computer or slightly before. 
 
Powering the RGB ADAPTER after the source computer may result in the source computer not 
correctly detecting the mouse, keyboard and/or monitor. 
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Fitting a Mains Plug 
 
If you are fitting a plug to the unterminated power cord (or replacing an existing plug), you must fit a 
plug that: 
 

• is rated for use with mains voltage 

• is equipped with a grounding pin/connection 

• complies with any applicable National or Local electrical regulations. 

• is fitted with a correctly rated fuse (applicable to UK-style plugs only – see page 22.) 
 
WARNING: Never attempt to fit or use a plug without a ground or earth pin/connection. 
 
 

Wiring Details 
 
The wires of both mains power cords (supplied with each RGB ADAPTER) are color-coded as shown 
in the table below; be sure to connect your plug in accordance with the following guidelines: 
 

Connect the wire 
colored... 

to the plug terminal identified 
with... 

Brown ‘L’ or ‘Live’ or ‘Line’ 
(or colored red or brown) 

Blue ‘N’ or ‘Neutral’ 
(or colored blue or black) 

Green & Yellow ‘E ’ or ‘E’ or ‘Earth’ or ‘Ground’ 
(or colored green or green & yellow) 

 

WARNING — If you are unsure of the connections, 
or if the markings in your plug do not match those 
given above, CONSULT A QUALIFIED ELECTRICIAN. 

 
 

NOTE: The PSU is double-insulated and does not require an earth/ground connection. However, the 
earth cable of the mains lead must be connected in the plug. 
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External Supply Protection 
 

 

The mains power cord supplied with this product is rated at 10A maximum and 
must be protected from overload by an external fuse or circuit breaker. 

 

Fused Plugs (UK-style) 

 
If the power cord is fitted with a UK-style BS1363 3-pin plug (i.e. with provision for an internal fuse), 
then it must be fitted with a BS1362 ASTA approved 1 inch cartridge fuse. 
 
This fuse must be rated at a maximum of 10A/250V. Since the current draw of the PSU is less than 
1A, a fuse of a lower rating not less that 3A/250V may be used. 
 
WARNING: Never attempt to fit a fuse or circuit breaker of a higher maximum rating than shown 
above. 
 

Unfused Plugs or Hard-wired 

 
If the power cord is fitted with an unfused plug, or is hard-wired into a power strip (mains distribution 
batten), then the power cord must be protected by an external fuse or circuit breaker of a rating shown 
in the table below: 
 

Supply Voltage 110V nominal 230V nominal 

Maximum Fuse Rating 10A 10A 

Minimum Fuse Rating 3A 3A 

WARNING: Never attempt to fit a fuse or circuit breaker of a higher 
maximum rating than shown above. 
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Connecting to a Computer  
 
The RGB ADAPTER is compatible with both digital (DVI) and analog graphics signals. The unit is 
provided with the necessary additional cables that you will require. 
 
For a Digital Source… 
 
� Use the following cables (replacement kit no. ES3610-CD)  

and refer to the connection diagram on page 24. 
 

• Mouse/Keyboard Cable (PS/2 to PS/2) (2 off), 

• Digital Monitor Cable (DVI-D to DVI-D). 
 
For an Analog Source… 
 
� Use the following cables (replacement kit no. ES3610-CA)  

and refer to the connection diagram on page 25. 
 

• Mouse/Keyboard Cable (PS/2 to PS/2) (2 off), 

• Analog Monitor Cable (15-pin Hi-Density D-type to DVI-A), plus 

• DVI-A to 15-pin Hi-Density D-type Adapter 
 
 

IMPORTANT NOTES 
 
The VN-GLIMPSE RGB ADAPTER does not provide Analog-to-Digital or Digital-to-Analog conversion 
via its monitor connections. A digital source must use a digital monitor and an analog source must use 
an analog monitor. 
 
Disconnecting and reconnecting PS/2 cables to a computer that is already switched on may cause 
loss of mouse/keyboard control or cause the computer to ‘freeze’. It is recommended, therefore, that 
the connections are made while the computer is powered-down. See also ‘Power-up Procedure’ on 
page 20. 
 
If you use a monitor cable or adapter other than that provided with the RGB ADAPTER you must 
ensure that all pins are properly interconnected, otherwise the computer graphics card or monitor may 
not operate correctly. 
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Connection Diagram (Digital Source) 
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Connection Diagram (Analog Source) 
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Connecting the RGB ADAPTER to a Network 
 
Source content captured by the RGB ADAPTER is transmitted to the viewing device using TCP/IP. 
The unit therefore requires a connection to an Ethernet network. 
 
CAUTION: Do not proceed with connecting or configuring the RGB ADAPTER for an existing network 
until you are certain you know what you are doing – incorrect connection or configuration may cause 
disruption to other network users. 
 

Network Requirements 

 
Typically, the RGB ADAPTER will connect to convenient network point on an existing in-house 
network. Use a standard patch cable for this purpose. This is not supplied with the RGB ADAPTER 
but is readily available in a variety of lengths from all good computer suppliers. Do not use the 
crossover patch cable supplied: this will not work. 
 
If a convenient network point is not available it will be necessary to have one installed – please 
consult the IT/Network Administrator or Building Facilities Manager for advice. Alternatively, the RGB 
ADAPTER and source computer can ‘share’ a connection by using a hub or switcher. 
 
In all cases you will need to obtain details about the following network settings to be used by the RGB 
ADAPTER: 
 

IP Address  Factory default = 172.28.231.98 

SubnetMask  Factory default = 255.255.0.0 

Device Name*   

DNS Server Address*   

WINS Server Address*   

Default Gateway*   

 
  * Optional settings – not required for correct operation. 
 
The Network Administrator should be able to provide this information. 
 
 

Setting the Correct IP Address  
 
It is important that the IP Address of the RGB ADAPTER is set correctly. This must be within the 
range of addresses specified for the network and must not be in use by another network device. The 
Subnet Mask must also be set to the correct value. A brief guide to IP Addressing is provided in 
Appendix A. 
 
The IP Address of the RGB ADAPTER can only be changed using the setup utility provided on the 
Software Disc.  See page 30 for further details on using this utility. 
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SECTION 3: 

VN-GLIMPSE Setup Utility 
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Introduction 
 
In many applications no special setup or configuration of the RGB ADAPTER will be required other 
than to set its IP Address and Subnet Mask. 
 
Any RGB ADAPTER configuration that is required is achieved by means of the VN-GLIMPSE Setup 
Utility provided on the Software Disc. The Setup Utility must be installed and run on a suitable PC or 
laptop computer (the ‘configuration computer’). 
 
HINT: You can install the Setup Utility on the source computer and use this machine to configure the 
RGB ADAPTER. 
 
The configuration computer must then be connected to the RGB ADAPTER via its Network port. 
There are two ways of achieving this:  
 

• Method 1 – Direct connection between the computer and the RGB ADAPTER (using a 
crossover patch cable – not supplied), or 

• Method 2 – Indirect connection between the computer and the RGB ADAPTER via an 
existing local area network (LAN). 

 
Method 1 is recommended as it allows the RGB ADAPTER to be configured without the risk of its 
default settings conflicting with other devices. Once the unit is configured it can be safely connected to 
the network. 
 
Method 2 can only be used if you are certain that the default settings will not cause a conflict with 
other network devices. This includes other RGB ADAPTERs. If you intend connecting and setting-up 
a number of RGB ADAPTERs on the same network, always power-up and configure each unit, one at 
a time. If all units are powered-up at the same time with the same default settings, configuration will 
be impossible. 
 
NOTE: The Setup Utility uses network broadcast messages to detect and communicate with the RGB 
ADAPTER. Therefore, the configuration computer and RGB ADAPTER(s) need not be on the same 
subnet (i.e. they can have different Subnet Masks). 
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Installing the Setup Utility 

Minimum Computer Specification 

 
The VN-GLIMPSE Setup Utility must be installed on a computer that meets or exceeds 
the following minimum specification: 
 

 Minimum Recommended 

Operating System Windows NT4 (SP6) Windows 2000, XP 

Processor Any processor with MMX 
instruction set 

Pentium 3 or higher 

Memory (RAM) 64MB 128MB 

Hard Disk Free Space 1MB >1MB 

Graphics 1024x768, 65K colors (16-bit) 1024x768, 16.7M colors (32-bit) 

Network Card Ethernet 10BASE-T Ethernet 100BASE-T 

 

Installation Procedure 

 
� Insert the Software Disc into a CD-ROM drive on the computer. After a few seconds the disc 

browser should start automatically. 
 
HINT: If the disc browser does not start for any reason, start it manually by running the setup.exe 
file located on the root of the disc. 
 

� Click on the Install VN-GLIMPSE Setup Utility option then follow the on-screen instructions. 
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Using the VN-GLIMPSE Setup Utility 
 
To start the Setup Utlity… 
 
� From the Start menu, choose Programs | Electrosonic | GlimpseConfigure. 
 

The Choose Glimpse dialog will appear, listing all VN-GLIMPSE RGB ADAPTERS found on the 
network: 

 

 
 
� Click on the address of the unit you want to connect to, and then click the OK button. 
 

The main dialog of the Setup Utility will then appear: 
 

 
 

HINT: If you want to select a different RGB ADAPTER, or check for a previously ‘missing’ unit, 
click the Discover Glimpse Agents button. The Choose Glimpse dialog will then reappear. 
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To change Network Settings (including IP Address)… 
 
� Click the Network Settings button. 
 

The Change Network Settings dialog will appear: 
 

 
 
� Change the settings as required. 
 

HINT: Here you can set a new IP address, subnet mask or select DHCP (automatic assignment of 
an address by the host network). In addition, you can assign a name to the RGB ADAPTER; this 
will require you to specify the address of a DNS and WINS server as well as the name. The name 
must be 1 to 15 characters long and comprise letters and numbers. It can also include the dash 
character ‘-‘ but must not contain any spaces. The first character must be a letter. 

 
 
� Click the Apply button to save the new settings or Exit to retain the existing settings. 
 

If you clicked Apply, the following message will display for a few seconds, while the new settings 
are stored: 

 

 
 

Once the settings have been saved, the following message will appear: 
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� Click OK to continue. The following dialog will now appear: 
 

 
 

� To reboot the RGB ADAPTER and implement the new settings now, click Yes. 
Otherwise, click No — the settings will be implemented the next time that the RGB ADAPTER is 
rebooted. 

 
 
To change Encoder Parameters (Stream Settings)… 
 
� Click the Stream Settings button. 
 

The Set Stream Settings dialog will appear: 
 

 
 

� To change the maximum refresh rate, adjust the Frames/Sec value. 
 

� To change the maximum bandwidth available to the RGB ADPATER, set the Bandwidth Limit 
value as required. 

 
HINT: For advice about using these parameters, see ‘Understanding VN-GLIMPSE Performance’ 

(pages 56-58). 
 

 
To check the current Firmware Version… 
 
� Click the Version button. 
 

The Version Information dialog will appear: 
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SECTION 4: 

VN-GLIMPSE VIEWER 
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Introduction 
 
The VN-GLIMPSE VIEWER is a small software application that is used to display VN-GLIMPSE 
sources on a conventional computer or laptop. 
 
VN-GLIMPSE sources are captured using either: 
 

• VN-GLIMPSE SERVER (software-based capture), or 

• VN-GLIMPSE RGB ADAPTER (hardware-based capture) 
 
Any number of VN-GLIMPSE sources can exist on a given network. VN-GLIMPSE VIEWER can 
connect to only one source at a time. 
 

Installing the Glimpse Viewer 

Minimum Computer Requirements 

 
The VN-GLIMPSE VIEWER must be installed on a computer that meets or exceeds the following 
minimum specification: 
 

 Minimum Recommended 

Operating System Windows NT4 (SP6) Windows 2000, XP 

Processor Any processor with MMX 
instruction set 

Pentium 3 or higher 

Memory (RAM) 64MB 128MB 

Hard Disk Free Space 1MB >1MB 

Graphics 1024x768, 65K colors (16-bit) 1024x768, 16.7M colors (32-bit) 

Network Card Ethernet 10BASE-T Ethernet 100BASE-T 

 

Installation Procedure 

 
� Insert the Software Disc into a CD-ROM drive on the computer. After a few seconds the disc 

browser should start automatically. 
 
HINT: If the disc browser does not start for any reason, start it manually by running the setup.exe 
file located on the root of the disc. 
 

� Click on the Install VN-GLIMPSE VIEWER option then follow the on-screen instructions. 
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Using the VN-GLIMPSE VIEWER 
 
To start the VN-GLIMPSE VIEWER… 
 
� From the Start menu, choose Programs | Electrosonic | VN-GlimpseViewer. 
 

VN-GLIMPSE VIEWER will now begin detecting VN-GLIMPSE sources available on the network. 
This process may take several seconds to complete, especially if there are a large number of 
sources. 
 
The VIEWER interface will then appear: 

 

 
 

On the left-hand side is the Source Window which displays the currently ‘connected’ source. When no 
source is connected, it appears black, with the message ‘Not Connected’. 
 
On the right-hand side is the Channel List which shows all the currently available VN-GLIMPSE 
sources. The following details are displayed for each source: 
 

• Glimpse Agent – network name of a hardware agent or the name of the host computer for a 
software agent; 

• IP Address – of the hardware agent or host computer for a  software agent; 

• Type – whether it is a Hardware or Software agent; 

• Protocol – the method used to carry source data across the network, either TCP Unicast 
(allowing one client connection) or UDP Multicast (allowing multiple clients). 

• Multicast Group* – the address of a Multicast source. 

• Port* – the port number being used by the Multicast source. VIEWER receives data on port 
5000 only. 

 
NOTE: Parameters marked * are not applicable to software agents (e.g. VN-GLIMPSE SERVER) 
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To refresh the Source List… 
 
The Channel List is not automatically updated to show the current status of all sources. For example, 
if a new source is added once VN-GLIMPSE VIEWER has been started, it will not automatically 
appear in the source list. 

To ensure that the list of VN-GLIMPSE sources is up-to-date you can manually refresh it (i.e. redetect 
all sources) by doing any one of the following: 
 
� Click the Refresh button on the Task area, or 

 
� Select Refresh Channel List from the View menu, or 

 
� Press F5 on the keyboard. 

 

IMPORTANT NOTE Sources that are located on a different subnet to VN-GLIMPSE VIEWER will not 
automatically appear in the Channel List. Use the Connect dialog box to connect to and view these 
sources (see page 38). 
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Source Connection and Disconnection 
 
To connect to a Source using the Channel List… 
 
� Double-click the required source name or IP Address in the Channel List. 

 
Alternatively, highlight the required source (single-click) then click the Connect button on the 
toolbar. 

 
HINT: If the required source is not displayed, try refreshing the list by clicking the Refresh button 
on the toolbar, or choosing Refresh Channel List from the View menu, or pressing F5 on the 
keyboard. 
 

 
To connect to a Source using the Connect dialog box… 
 
� From the File menu choose Connect To. The following dialog will appear: 
 

 
 
� Enter either the IP Address or Name of the source that you want to connect to. 

 
HINT: The drop-down list shows the most recently entered or selected sources. If required, you 
can select one of these.  
 

� Click the Connect button. 
  
 

To disconnect from a source… 
 
� Click the Disconnect button on the toolbar. 

 
Alternatively, choose Disconnect from the File menu. 
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Viewing Options 
 
The VN-GLIMPSE VIEWER provides a number of options for setting the viewing environment. You 
can choose to: 
 

• View the source at its original resolution (unity) or scaled to fit the available window size. 

• View the source full screen (i.e. without the menu bar, toolbar, channel list, etc.) 

• Hide/show the VIEWER toolbar, channel list and/or status bar. 

• Hide/show the current source refresh rate and data bandwidth on the status bar. 
 

 
To view the source full screen… 
 
� Click the Full Screen button on the toolbar. 

 
Alternatively, choose Full Screen from the View menu, or press Alt+Enter on the keyboard. 

 
� To return to normal view press Esc or Alt+Enter on the keyboard. 

 
 
To select unity or scale mode… 
 
� Click the Unity or Scale button on the toolbar. 

 
Alternatively, choose Unity or Scale from the View menu. 

 
NOTE: If the source is larger than the available window space, selecting the unity option will crop 
the visible image. Scroll bars will appear allowing you to select which part of the source frame you 
want to view. 
 

 
To hide/show the toolbar, channel list or status bar… 
 
� From the View menu choose either Toolbar, Status Bar or Channel List to toggle the item 

visibility. 
 
The corresponding item is visible when a checkmark is displayed next to it in the menu. 

 
 
To hide/show the source refresh rate on the status bar… 
 

 
 
� From the View menu choose Frame Rate Display to toggle the item visibility. 
 

NOTE: The maximum capture rate is defined by the VN-GLIMPSE SERVER or  
VN-GLIMPSE RGB ADAPTER that is streaming the source. It cannot be changed  
using the VN-GLIMPSE VIEWER.  
 
HINT: To set the maximum capture rate of a VN-GLIMPSE RGB ADAPTER, use either the  
Setup Utility (see page 32) or the VN-GLIMPSE ADMINISTRATOR application (supplied on the 
Software Disc). To set the refresh rate of a VN-GLIMPSE SERVER, choose Set Capture Rate 
from the Capture Rate menu, and then enter the new maximum rate (captures/sec). 
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Remote Mouse and Keyboard Control 
 
This feature allows the mouse and keyboard (of the computer running VN-GLIMPSE VIEWER) to 
emulate mouse and keyboard operation on the source computer. 
 
Remote mouse and keyboard control can be used with software agents and also with hardware 
agents that are operating in TCP unicast mode. Hardware agents operating in UDP multicast mode 
cannot be remotely controlled since they can have more than one viewing client connected. 
 
A remote control ‘session’ is initiated by the viewing client. A session can be terminated automatically 
after a preset period of mouse/keyboard inactivity (‘timeout’), or manually by pressing a predefined 
‘hot key’ on the keyboard. 
 
 
To enable/disable remote mouse and keyboard control… 
 
� From the Tools menu choose Mouse & Keyboard. 
 

When this option is checked, remote control is enabled.  
When this option is unchecked, remote control is disabled. 

 
 
To set up mouse and keyboard control options… 
 
� From the Tools menu choose Mouse & Keyboard Options to show the following dialog: 

 
 
 

 
 

 
� Change the settings as required, and then click OK to save the settings. 

 

To specify the key (or key combination) that will 
be used to terminate the session, click in this 
box then press the required key(s). 

This example requires the Ctrl key and F1 
function key to be pressed simultaneously. 

To specify the key (or key combination) that will 
be used to call up the special context menu, 
click in this box then press the required key(s). 

This example requires the Ctrl key and F2 
function key to be pressed simultaneously. 

To enable automatic session termination check 
the Enable Timeout box. Then set the required 
timeout period by typing the required value in 
the Timeout In Seconds box. 



Section 4: VN-GLIMPSE VIEWER  ES3610/11 User Guide 

Page 40  I447GB issue 6 

Using Mouse and Keyboard Control 

 
To use remote mouse and keyboard control you first need to ‘connect’ to the source and open a 
viewer window (as described on page 38). 
 
 
To start a mouse and keyboard control session… 
 
� Click anywhere in the source area of the viewer window.  

 
A red border will appear around the source area, showing that a control session is now active. 
 

� You can now use the mouse and keyboard to control the source computer. 
 
Remember, if automatic session termination is enabled (see page 40) the session will terminate 
after a predefined period of mouse and keyboard inactivity. 
 
 

To manually stop a mouse and keyboard control session… 
 
� Press the predefined key (or key combination) on the keyboard. By default this is set to Ctrl+F1 

(i.e. pressing the Ctrl and F1 function keys simultaneously). 
 

 
To access the special context menu during a control session… 
 
� Press the predefined key (or key combination) on the keyboard. By default this is set to Ctrl+F2 

(i.e. pressing the Ctrl and F2 function keys simultaneously). 
 
The context menu allows access to send the following ‘special’ keys and key combinations to the 
remote computer: 

 
Ctrl + Alt + Delete to call up the Windows Security (Task Manager) dialog 
Windows key to display the Windows Start menu 
Windows + Tab to switch between applications 
End Keyboard And Mouse (to end the control session) 
 

� Click the required option to continue, or the Esc key to clear the menu. 
 



ES3610/11 User Guide  Section 4: VN-GLIMPSE VIEWER 

I447GB issue 6  Page 41 

Learning Dialogs 
 
When performing certain operations, VN-GLIMPSE VIEWER displays a ‘learning dialog’ giving helpful 
tips and information. As you get more familiar with using VIEWER you may prefer to turn off these 
dialogs. 
 
� From the Tools menu, choose Options to open the following dialog: 

 

 
 
 
� Uncheck the appropriate boxes to disable the learning dialogs, then click OK. 
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Command line switch options 
The VN-GLIMPSE VIEWER may be launched with a number of command line switches that affect its 
startup behavior.  
 

Command line 
switch 

Function 

-c [server IP address] Connect to server 

-r Connect to last server 

-f, -s, -u Display mode  
-f = Full screen 
-s = Scaled screen 
-u = Unity mode 

-n Do not show splash 
screen on start up 

-t Hide tool bar 

-a Hide status bar 

-l Hide channel list 

-m Hide main menu 

-d No discovery on launch 
  
The command line switches may be used separately of together 
 
 
Command line switch examples: 
 
� To connect to a server on launch 

 
“C:\Program Files\Electrosonic\VN-Glimpse Viewer 5\VN-Glimpse Viewer.exe” -c 172.28.228.105 

Note:  
There are quotation marks around the path and application part of the command line;  
There are spaces before and after the –c. 

 
� To connect to a server on launch and hide the splash screen 

 
“C:\Program Files\Electrosonic\VN-Glimpse Viewer 5\VN-Glimpse Viewer.exe” -c 172.28.228.105 -n 

Note:  
The space before the –n.  

 
� To connect to a server on launch, hide the splash screen and display in unity mode 

 
“C:\Program Files\Electrosonic\VN-Glimpse Viewer 5\VN-Glimpse Viewer.exe” -c 172.28.228.105 –n -u 

Note:  
The space before the –u.  



ES3610/11 User Guide  Section 5: Technical Data 

I447GB issue 6  Page 43 

SECTION 5: 

Technical Data 
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Mechanical Data 
Overall Dimensions: Width: 200mm (7.9 inches) 

Depth: 155mm (6.125 inches) [including rear sockets] 
Height: 44mm (1.75 inches)  [excluding rubber feet] 
 47mm (1.85 inches)  [including rubber feet] 

Average Weight: 0.67 kg (1.5 lbs) 
 

Operating Conditions 
Ambient Temperature: 5°C to 35°C (41°F to 95°F). 

Ambient Humidity: 85% maximum (non-condensing). 
Location: Free-standing or 19” Rack-mounting (using approved kit). 

 

Power Supply 
RGB ADAPTER  

Supply Voltage: 12V DC Regulated. 
Supply Current: 1.5A max. 

  
PSU  

Supply Voltage: 100 – 240V AC nominal. 
Supply Frequency: 50 – 60 Hz nominal. 

Supply Current: 0.45A maximum. 
Supply Connector: IEC320 ‘Europlug’. 
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Control Inputs/Outputs 
 

Keyboard/Mouse Connectors 

Function: Keyboard and mouse pass-through connections for source computer. 
Connector Type: 6-pin mini-DIN (female) 

Pin-out Details:  

 
 

Pin Function 

1 Data 
2 No connection 

3 Ground 

4 +5V supply* 

5 Clock 
6 No connection 

 
* 5V on pin 4 limited to 200mA by thermal fuse. 

 
Mating Connector: 6-pin mini-DIN (male). 

Recommended Cable: Supplied PS/2 cable. 
Max. Cable Length: 2.95 metres (9.5 feet). 

 



Section 5: Technical Data  ES3610/11 User Guide 

Page 46  I447GB issue 6 

Monitor Connectors 

Function: Monitor pass-through connections for source computer. 
Connector Type: DVI-I (female). 

Pin-out Details:  

 
 
Digital Connections 

Pin Function Pin Function Pin Function 

1 TMDS 2- 9 TMDS 1- 17 TMDS 0- 
2 TMDS 2+ 10 TMDS 1+ 18 TMDS 0+ 
3 Ground (2/4) 11 Ground (1/3) 19 Ground (0/5) 

4 TMDS 4- 12 TMDS 3- 20 TMDS 5- 
5 TMDS 4+ 13 TMDS 3+ 21 TMDS 5+ 

6 DDC Clock 14 +5V supply* 22 Ground (Clk) 

7 DDC Data 15 Ground (for 5v) 23 TMDS Clock+ 
8 Analog V-Sync 16 Hot Plug Detect 24 TMDS Clock- 

 
* Loop-thru connection only — 5V supply is provided by source. 

 
Analog Connections 

Pin Function 

C1 Red Signal 
C2 Green Signal 
C3 Blue Signal 

C4 Horizontal Sync 
 C5 Ground 

 
 

Mating Connector: DVI-D or DVI-I (male). 
Recommended Cable: Supplied DVI cables. 

Maximum Cable Length: 2.95 metres (9.5 feet). 
Signal Type: DVI (PanelLink® TMDS). 
Pixel Clock: 25MHz – 165MHz. 

Supported Sources: See table on page 48. 
Color Depth: 24-bit maximum. 
Scan Mode: Progressive. 

DVI Standard: DVI 1.0 
Display Data Channel 

Standard: 
 
DDC2B. 

DDC Levels: VIH = 2.4V 
VOH = 0.9V 
ILOADMAX = 2mA 

 

NOTE:  
Analog Vertical Sync 
is on pin 8. 
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Supported Source Formats 

 
Analog Source Resolution Digital 
H & V Sync Composite Sync Sync on Green 

640x480@60Hz � � � � 

640x480@72Hz � � � � 

640x480@75Hz � � � � 

640x480@85Hz � � � � 

     

600x800@56Hz  � � � 

600x800@60Hz � � � � 

600x800@72Hz � � � � 

600x800@75Hz � � � � 

600x800@85Hz � � � � 

     

1024x768@60Hz � � � � 

1024x768@70Hz � � � � 

1024x768@72Hz �    

1024x768@75Hz � � � � 

1024x768@85Hz � � � � 

     

1152x864@75Hz � � � � 

     

1280x1024@60Hz � � � � 

1280x1024@75Hz  � � � 

1280x1024@85Hz  � � � 

     

1600x1200@60Hz (162MHz)  � � � 

1600x1200@60Hz (135MHz)     
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Network Connector 

Function: Connection to a local area network and/or control PC. 
Connector Type: Shielded RJ-45 Socket. 

Pin-out Details: 

 
Pin Function Pin Function 

1 TD+ (+ data transmit) 5 NC 
2 TD- (- data transmit) 6 RD- (- data receive) 

3 RD+ (+ data receive) 7 NC 

4 NC 8 NC 

 
 

Mating Connector: Shielded RJ-45 Plug. 
Recommended Cable: Shielded twisted pair (STP). 

Max. Cable Length: 100 metres (330 feet). 
Comms Standard: 10Base-T, 100Base-T. 

Ethernet (MAC) 
Address: 

00:E0:AA:03:xx:xx 
where xx:xx is a unique hex address for each unit. 

IP Address: Factory-set default is 172.28.231.98. 
User-definable via setup utility & VN-GLIMPSE ADMINISTRATOR. 
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Serial (RS-232) Connectors  

Function: COM1 – used for low level setup or system recovery. 
COM2 – reserved for future expansion. 

Connector Type: 9-pin D-type (male) 
Pin-out Details: 

 
 

Pin Function Pin Function 

1 DCD 6 DSR 

2 RX (data in) 7 RTS 
3 TX (data out) 8 CTS 
4 DTR 9 RING 

5 Ground   

 
 

Mating Connector: 9-pin D-type (female) with metal cover 
Recommended Cable: 6-core plus overall screen (low capacitance), 

0.22mm
2
 min. per core. 

Max. Cable Length: 2.95 metres (9.5 feet). 
Comms Standard: RS-232. 

COM1 Default Setting:  Baud:   115200 
Bits:   8 
Parity:   None 
Stop Bits:  1 
Flow Control:  None 
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APPENDIX A: 

Guide to IP Addressing 
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What is an IP Address? 
 
A full explanation of IP addressing is beyond the scope of this user guide. However the following 
details will provide you with enough information to get started. 
 
An IP Address is a 32-bit binary number that is used to identify each device on an Ethernet network. 
This number is usually represented by four decimal numbers (each in the range 0 to 255) separated 
by dots, e.g. 198.123.34.240. This is called ‘dotted decimal notation’. 
 
An IP Address is divided into two parts: 
 

• the ‘network identifier’, and 

• the ‘host identifier’. 
 

On a given network each address must have the same network identifier value but have a unique host 
identifier. There are, therefore, different ‘classes’ of address which define: 
 

• the range of valid addresses, and 

• which parts of the address are used for the network and host identifiers. 
 

The most common IP Address classes are: 
 
Class Name Valid Address Range Identifier Arrangement* 

Class A  0.0.0.1 to 127.255.255.254  NNN.HHH.HHH.HHH 

Class B  128.0.0.1 to 191.255.255.254  NNN.NNN.HHH.HHH 

Class C  192.0.0.1 to 223.255.255.254  NNN.NNN.NNN.HHH 

 
*Where:NNN = Network identifier 

HHH = Host identifier 
 

Private & Public Address Ranges 

 
Within each of the above classes are a range of addresses designated as ‘private’ addresses. These 
are addresses which should only ever be used on private local networks and intranets and cannot be 
accessed directly from the internet. 
 
10.0.0.0 – 10.255.255.255 
172.16.0.0 – 172.31.255.255 
169.254.0.0 –169.254.255.255 
192.168.0.0 – 192.168.255.255 
 
All other addresses outside these ranges are considered ‘public’ addresses. 
 

Multicast Address Range 

 
A further range of addresses are available for multicast usage: 
 
224.0.0.0 – 239.255.255.255 
 
These addresses (also known as Class D addresses) are used to allow several devices to be part of 
the same multicast group. Each device in the group has the same multicast address and can 
effectively send data to all other devices in the same group simultaneously. 
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Choosing IP Addresses 
 
If your RGB ADAPTER(s) and control PC are directly connected, or connected via their own 
independent network, then follow the guidelines below for choosing your IP Address(es). 
 
However, if you intend connecting your RGB ADAPTER (s) and control PC to an existing network, you 
will need to advise the network administrator and ask them to allocate suitable addresses to you. 
 
On an independent network you can (in theory) use just about any addresses you wish. However, it is 
generally recommended that you use the Class C format (i.e. from 192.0.0.1 up to 223.255.255.253). 
 
Remember that there are two rules for choosing IP Addresses: 
 

• the network identifier must be the same for each address, and 

• the host identifier must be unique for each address. 
 

Applying these rules to Class C addresses, it can be seen that the first three decimal values of your IP 
Addresses must all be the same, while the last value is used to uniquely identify each device. 
The following is an example of a valid Class C addressing scheme: 
 
Device IP Address 

Device 1 208.132.180.41 

Device 2 208.132.180.42 

Device 3 208.132.180.43 

 
NOTE: The host identifiers (e.g. 41, 42, and 43 in the above example) need not be sequential or in 
any particular order. However, it is recommended that you group the numbers for simplicity. 
 
The following is an example of an invalid Class C addressing scheme: 
 
Device    IP Address 

Device 1  208.132.180.41 

Device 2  192.157.180.42 

Device 3  209.100.123.43 

 
NOTE: These are invalid because the network identifier for each address is not the same, even 
though each IP Address is unique. 
 
You can use the Ping command from your computer to check that a device at a particular address is 
responding correctly (see page 54). 
 

Subnet Mask 

 
The Subnet Mask is another 32-bit binary number that is used to ‘mask’ certain bits of the IP Address. 
This provides a method of extending the number of network options for a given IP Address. It works 
by allowing part of the host identifier to be used as a ‘subnet identifier’. Any further explanation of this 
facility is not relevant here. 
 
However, it is important that you set the correct value for the Subnet Mask. The basic values depend 
on the class of IP Address being used: 
 
Class Name  Subnet Mask 

Class A  255.0.0.0 

Class B  255.255.0.0 

Class C  255.255.255.0 
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Using the ‘Ping’ Utility to Test Communications 
 
You can test for communications between a Windows computer and another device on the same 
network by using the Windows Ping utility. 
 
� From the Windows Desktop of the computer, click on the Start button, and select Run from the 

pop-up menu. 
 

The Run dialog box will appear. 
 
� In the Open box, type in the following command: 
 

ping xxx.xxx.xxx.xxx –t 

 
where xxx.xxx.xxx.xxx is the IP Address of the device (e.g. an RGB ADAPTER) that you want to 
test. 
 

� Click on the OK button or press the Enter key. 
 

A text window will appear showing a series of response messages; these are explained below. 
 
� To stop the ping utility, press Ctrl + C on the keyboard. 
 

Response Messages 

 
When you run the Ping utility, it will display a series of response messages, which you can use to 
determine the state of the communications link. For example, if you have ‘pinged’ a device with the 
address 208.132.180.48, you should get a message similar to the following: 
 

Reply from 208.132.180.48: bytes=32 time=2ms TTL=32 

 
This is the correct response which indicates that the device at the specified address is communicating 
correctly. Note that the response ‘time’ value may vary according to network traffic. 
 
If you get the message... 
 

Request timed out. 

 
...this indicates that there has been no response from the specified address. Either the processor is 
not receiving data from the computer or not sending data back. Check that the device is powered-up 
and set to the same address that you ‘pinged’. Also, check that you are using the correct type of 
connecting cables (i.e. ‘straight through’ or ‘crossover’) and that they are not damaged or faulty. 
 
If you get the message... 
 

Reply from 208.132.180.48: Destination host unreachable. 

 
…this indicates that the IP Address of the computer is not in the same ‘class’ (or subnet) as that of the 
device being ‘pinged’. Check that the SubNet Mask on both the computer and the device are set to 
the same value (see page 53). Also check that both IP Address are within the correct range for the 
chosen class and are compatible (see page 53). 
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Understanding VN-GLIMPSE Performance 
 
In an ideal VN-GLIMSPE system, the source seen at the viewing station should be virtually 
indistinguishable from the original source. However, in certain circumstances, you may notice some 
reduction in performance. The following details are intended to explain the problems you may 
encounter and how to minimize or avoid them. 
 

What are the performance criteria? 
 
Image Refresh Rate – how often the display content is updated. Ideally this should match (or be as 
close as possible to) the refresh rate of the original source. As the refresh rate decreases a loss of 
smooth motion will be noticed. For example, a moving mouse cursor will appear to move smoothly at 
a fast refresh rate but will appear more ‘jerky’ at slower rates. 
 
The RGB ADAPTER features a variable source refresh/update rate. To ensure smooth motion it will 
use the highest possible refresh rate. However, during periods of intense screen activity, the refresh 
rate may be temporarily reduced to compensate for the higher volume of data. 
 
Image Latency – how quickly a change in the original source takes to be seen in the viewed source. 
Ideally this should be instantaneous (i.e. in ‘real time’). In practice, there will always be some delay 
introduced by the electronics and software that processes the data between the original source and 
the viewing station, but this will usually be small enough to be ignored. As the latency increases a 
greater ‘time lag’ will become noticeable between events happening in the original source and the 
same events being seen in the viewed source.  
 
Image Quality – the sharpness and color of the viewed source in comparison to the original. When 
viewed at the same resolution as the original, there should be no discernable differences. However, if 
any scaling is applied to the source (i.e. displayed smaller or bigger than the original) there will always 
be some small loss of sharpness. This is an inherent side-effect of image scaling. 
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What can affect these criteria? 

Data Stream ‘Bottlenecks’ 

The VN-GLIMPSE RGB ADAPTER only streams data relating to ‘changes’ in the source display. 
Therefore, a source containing a lot of movement (e.g. an MPEG movie) will create more data than a 
source with little or no movement (e.g. a spreadsheet file). Changes in latency or refresh rate can 
arise when a ‘bottleneck’ occurs at some point in the data path which restricts the flow of data. The 
potential bottlenecks are: 
 
Data Encoding – Data from the source capture process is encoded into a VN-GLIMPSE data stream 
and sent to the network. Under normal circumstances, the RGB ADAPTER is capable of encoding 
most sources without any difficulty. However, if you are using a high resolution source containing a lot 
of movement, the encoder may generate more data than can be transmitted between frame captures. 
In this situation the encoder can temporarily reduce the refresh rate allowing more time for the data to 
be sent. See ‘Adjusting the Encoder Parameters’ (page 58). 

 
Network Bandwidth – This is the total volume of data that can be handled by the network at any 
given time. If you have a high bandwidth network and only one RGB ADAPTER it is unlikely that you 
will ever experience any problems. However, in extreme circumstances if you have a low bandwidth 
network, a network with heavy traffic, or you are using several RGB ADAPTERs, you may find that the 
available bandwidth is insufficient to cope during peak demand. It is important to note that the network 
will only be as good as its weakest link. For example, if you have a 100BASE-T network with a 
10BASE-T router, the effective bandwidth could be much less than expected. 
 
Data Decoding – Whatever viewing platform you are using (i.e. the VN-GLIMPSE VIEWER running 
on a computer or a VN-2400 Processor) the efficiency with which the data stream is decoded will 
largely depend on the capacity of CPU (central processing unit). As with the encoding process, the 
decoder can choose to reduce the refresh rate. 
 
The most likely cause of a bottleneck here is by placing too much demand on the CPU, such that it 
cannot decode the VN-GLIMPSE data stream quickly enough: 
 

• If you are using the VN-GLIMPSE VIEWER, the CPU of the computer should be as fast as 
possible. Also, remember that running other applications at the same time as the VIEWER will 
create extra demand for the CPU. 

• If you are using a VN-2400 Processor, remember that the number of sources it is displaying 
together with the content of those sources will impact on how much work the CPU has to do. 

• Sources that are scaled up or down (rather than being viewed at their native resolution) will 
require more CPU time. See ‘Source Scaling’ below. 

Source Scaling 

For optimum viewing, it is preferable to display a source at its native resolution (i.e. unity, not scaled). 
This results in the viewed source being simply a pixel-for-pixel copy of the original. This keeps 
processing to a minimum and ensures the best possible image quality. 
 
Scaling a source requires each pixel value to be recalculated and, consequently, will place a high 
demand on the CPU. This can lead to increased latency and reduced refresh rates as described 
above. In addition, since each pixel is recalculated, the image may not appear as sharp as the 
original. This will become more noticeable as the image gets smaller, especially if the image contains 
fine detail.   

HINT: Apart from the improved image quality provided by digital sources, they are also more 
efficient on encoding. This is because analog sources invariably contain a certain amount of noise 
and this can add to the overall content of the data stream. In addition, analog sources may produce 
‘contouring’ effects during motion. 



Appendix B: Understanding VN-GLIMPSE Performance  ES3610/11 User Guide 

I447GB issue 6  Page 57 

Adjusting the Encoder Parameters 
 
Using the VN-GLIMPSE Setup Utility (see page 32) you can set the following parameters: 
 

• Bandwidth Limit – If you are using a large number of RGB ADPATERS or you have a 
slow/busy network, you can reduce this value which sets the maximum possible flow of data 
being streamed onto the network. However, remember that this could cause the refresh rate 
to be reduced, especially during periods of high source activity. 

 

• Refresh Rate (frames/sec) – If you have a source which does not require a particularly high 
refresh rate, but has a reasonably active content you can set the maximum possible refresh 
using this value. By keeping the Bandwidth Limit high you can keep both latency and the 
average bandwidth usage to a minimum. 
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